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BETA TESTER AGREEMENT 

 

You have volunteered or have been selected to participate in the pre-operation testing of the geo-steering 
program, Rig Steer. Before becoming a beta tester for this program you will need to agree to this document.  

While using this software you must agree to the terms of use. 

•         You agree that this software is ‘Use at Your Own Risk’ software that is not responsible for any loss of data or 
information. Rig Steer will not be held responsible for any misuse or data corruption that might occur during the use 
of this software.  

•         You agree to not share any information about this software or information retaining to this software through any 
form of communication outside of the beta testers who are also testing this software. Communications or posting 
information about this software is strictly prohibited. 

•         You agree to not steal, borrow, copy, manipulate or store any information, code, projects or data files from this 
software. In doing so you agree to use the software as it was intended and to not share this software with any 
individuals, companies or communities.  

•         You agree to not create email accounts, legal papers, documentation, trademarks, marketing supplies, materials, 
brochures, presentations or any related documents regarding Rig Steer.  

•         You agree that you do not own any rights to the software/program Rig Steer. You know and agree that you are 
simply a tester and own no claim on the program in which you are testing. 

•         You agree that you will not share any information about this software with any company, individual, community, 
forum, blog, corporation or competing software provider about this program during its testing period.  

  

All beta testers agree by this document that they will not be getting any currency for their work.  

Beta testers, while testing, will receive a generated license to do testing on. These licenses are machine 
specific and are linked to your individual computer. Any sharing of this software will be linked back to the 
distributor of the leaked information and legal action will be taken to preserve the software from being released 
before publication date.  

Beta testers will be required to email all found errors or problems to rigsteer@rigsteersoftware.com . 
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Rig Steer Privacy Policy 

This privacy policy has been compiled to better serve those who are concerned with how their 'Personally 
identifiable information' (PII) is being used online. PII, as used in US privacy law and information security, is 
information that can be used on its own or with other information to identify, contact, or locate a single person, or to 
identify an individual in context. Please read our privacy policy carefully to get a clear understanding of how we 
collect, use, protect or otherwise handle your Personally Identifiable Information in accordance with our website. 

What personal information do we collect from the people that visit our blog, website, program, software or 
app? 

When ordering or registering on our site, program or software, as appropriate, you may be asked to enter your name, 
email address, mailing address, phone number, credit card information or other details to help you with your 
experience. 

  

When do we collect information? 

We collect information from you when you register on our site, program or software, place an order, subscribe to a 
newsletter, fill out a form or enter information on our site, program or software. 

  

How do we use your information? 

We may use the information we collect from you when you register, make a purchase, sign up for our newsletter, 
respond to a survey or marketing communication, surf the website, download or register our software or programs, 
or use certain other site features in the following ways: 

  

      • To personalize user's experience and to allow us to deliver the type of content and product offerings in which 
you are most interested. 

      • To improve our website, program or software in order to better serve you. 

      • To allow us to better service you in responding to your customer service requests. 

      • To quickly process your transactions. 

      • To send periodic emails regarding your order or other products and services. 

  

How do we protect visitor information? 

Our website, program and software is scanned on a regular basis for security holes and known vulnerabilities in 
order to make your visit to our site, software and programs as safe as possible. 
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We use regular Malware Scanning. 

We do not use an SSL certificate 

      • We do not need an SSL because: 

We do not store any personal information on our website. 

  

Do we use 'cookies'? 

We do not use cookies for tracking purposes 

  

You can choose to have your computer warn you each time a cookie is being sent, or you can choose to turn off all 
cookies. You do this through your browser (like Internet Explorer) settings. Each browser is a little different, so look 
at your browser's Help menu to learn the correct way to modify your cookies. 

  

If you disable cookies off, some features will be disabled that make your site experience more efficient and some of 
our services will not function properly. 

  

However, you can still place orders or use our software or programs. 

  

  

Third Party Disclosure 

We do not sell, trade, or otherwise transfer to outside parties your personally identifiable information unless we 
provide you with advance notice. This does not include website hosting partners and other parties who assist us in 
operating our website, conducting our business, or servicing you, so long as those parties agree to keep this 
information confidential. We may also release your information when we believe release is appropriate to comply 
with the law, enforce our site policies, or protect ours or others' rights, property, or safety.  

However, non-personally identifiable visitor information may be provided to other parties for marketing, 
advertising, or other uses. 

  

Third party links 
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Occasionally, at our discretion, we may include or offer third party products or services on our website, programs or 
software. These third party sites, programs of softwares have separate and independent privacy policies. We 
therefore have no responsibility or liability for the content and activities of these linked sites. Nonetheless, we seek 
to protect the integrity of our site and welcome any feedback about these sites. 

  

Google 

Google's advertising requirements can be summed up by Google's Advertising Principles. They are put in place to 
provide a positive experience for users. https://support.google.com/adwordspolicy/answer/1316548?hl=en  

  

We have not enabled Google AdSense on our site, programs or software but we may do so in the future. 

  

California Online Privacy Protection Act 

  

CalOPPA is the first state law in the nation to require commercial websites and online services to post a privacy 
policy. The law's reach stretches well beyond California to require a person or company in the United States (and 
conceivably the world) that operates websites collecting personally identifiable information from California 
consumers to post a conspicuous privacy policy on its website stating exactly the information being collected and 
those individuals with whom it is being shared, and to comply with this policy. - See more at: 
http://consumercal.org/california-online-privacy-protection-act-caloppa/#sthash.0FdRbT51.dpuf 

  

According to CalOPPA we agree to the following: 

Users can visit our site anonymously 

Once this privacy policy is created, we will add a link to it on our home page, or as a minimum on the first 
significant page after entering our website. 

Our Privacy Policy link includes the word 'Privacy', and can be easily be found on the page specified above. 

  

Users will be notified of any privacy policy changes: 

      • On our Privacy Policy Page 

Users are able to change their personal information: 

      • By emailing us 

      • By calling us 

Rig Steer Beta Version 0.1.1.9 Manual Page 6 
 



  

How does our site, program or software handle do not track signals? 

We honor do not track signals and do not track, plant cookies, or use advertising when a Do Not Track (DNT) 
browser mechanism is in place. 

  

Does our site, program or software allow third party behavioral tracking? 

It's also important to note that we do not allow third party behavioral tracking 

  

COPPA (Children Online Privacy Protection Act) 

  

When it comes to the collection of personal information from children under 13, the Children's Online Privacy 
Protection Act (COPPA) puts parents in control. The Federal Trade Commission, the nation's consumer protection 
agency, enforces the COPPA Rule, which spells out what operators of websites and online services must do to 
protect children's privacy and safety online. 

  

We do not specifically market to children under 13. 

  

Fair Information Practices 

  

The Fair Information Practices Principles form the backbone of privacy law in the United States and the concepts 
they include have played a significant role in the development of data protection laws around the globe. 
Understanding the Fair Information Practice Principles and how they should be implemented is critical to comply 
with the various privacy laws that protect personal information. 

  

In order to be in line with Fair Information Practices we will take the following responsive action, should a 
data breach occur: 

We will notify the users via email 

      • Within 7 business days 

We will notify the users via in site notification 

      • Within 7 business days 
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We also agree to the individual redress principle, which requires that individuals have a right to pursue legally 
enforceable rights against data collectors and processors who fail to adhere to the law. This principle requires not 
only that individuals have enforceable rights against data users, but also that individuals have recourse to courts or a 
government agency to investigate and/or prosecute non-compliance by data processors. 

  

CAN SPAM Act 

  

The CAN-SPAM Act is a law that sets the rules for commercial email, establishes requirements for commercial 
messages, gives recipients the right to have emails stopped from being sent to them, and spells out tough penalties 
for violations. 

  

We collect your email address in order to: 

      • Send information, respond to inquiries, and/or other requests or questions. 

      • Process orders and to send information and updates pertaining to orders 

      • We may also send you additional information related to your product and/or service. 

      • Market to our mailing list or continue to send emails to our clients after the original transaction has occurred 

  

To be in accordance with CANSPAM we agree to the following: 

      • NOT use false, or misleading subjects or email addresses 

      • Identify the message as an advertisement in some reasonable way 

      • Include the physical address of our business or site headquarters 

      • Monitor third party email marketing services for compliance, if one is used. 

      • Honor opt-out/unsubscribe requests quickly 

      • Allow users to unsubscribe by using the link at the bottom of each email 

  

If at any time you would like to unsubscribe from receiving future emails, you can 

Email us at rigsteer@rigsteersoftware.com and we will promptly remove you from ALL correspondence. 
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Contacting Us 

  

If there are any questions regarding this privacy policy you may contact us using the information below. 

 

www.rigsteersoftware.com  

 

Gray Technical, LLC 

Rig Steer 

Morehead 

United States 

1690 Sharkey Road 

Kentucky 

40351 

rigsteer@rigsteersoftware.com 

606-780-0554 

  

Last Edited on 2015-03-16 
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Program, Software and Website Terms and Conditions of Use 

1. Terms  

By accessing this program, software or website you are agreeing to be bound by these Terms and Conditions of Use, 
all applicable laws and regulations, and agree that you are responsible for compliance with any applicable local 
laws. If you do not agree with any of these terms, you are prohibited from using or accessing this software. The 
materials contained in this program, software or website are protected by applicable copyright and trademark law.  

2. Use License  

a. Permission is granted to download one copy, per machine, of the materials (information or software) on 
Gray Technical, LLC’s (and Rig Steer's) web site, program or software for personal and commercial 
transitory use. This is the grant of a license, not a transfer of title, and under this license you may not:  

i. modify or copy the materials; 
ii. use the materials for any unauthorized purpose, or for any public display (commercial or non-

commercial); 
iii. attempt to decompile or reverse engineer any software available through Gray Technical, LLC; 
iv. remove any copyright or other proprietary notations from the materials; or 
v. transfer the materials to another person or "mirror" the materials on any other server. 

b. This license shall automatically terminate if you violate any of these restrictions and may be terminated by 
Gray Technical, LLC at any time. Upon terminating your viewing of these materials or upon the 
termination of this license, you must destroy any downloaded materials in your possession whether in 
electronic or printed format.  

c. Licenses are generated based on a “computer specific” number, and therefore have licenses that are 
“computer specific”. For more information on this please see Section 3, Section b. 

3. Disclaimer  

a. The materials of Rig Steer are provided "as is". Gray Technical, LLC makes no warranties, expressed or 
implied, and hereby disclaims and negates all other warranties, including without limitation, implied 
warranties or conditions of merchantability, fitness for a particular purpose, or non-infringement of 
intellectual property or other violation of rights. Further, Gray Technical, LLC does not warrant or make 
any representations concerning the accuracy, likely results, or reliability of the use of the materials on any 
of its software, programs or Internet web site or otherwise relating to such materials or on any sites linked 
to this site.  

b. The licensing agreement made by Gray Technical, LLC to the consumer/customer is based on a “computer 
specific” license code. Each code is meant to only be used on the computer in which it is registered. If the 
computer in which the program is registered becomes unusable or has parts replaced, the computer specific 
number generated may change. When purchasing this software you, as the consumer/customer, agree that 
Gray Technical, LLC is not responsible for issuing a new license free of charge regardless of the reason. In 
the instance of a change of the computer specific number a new license will have to be purchased.    

4. Limitations  

In no event shall Gray Technical, LLC or its suppliers be liable for any damages (including, without limitation, 
damages for loss of data or profit, or due to business interruption,) arising out of the use or inability to use the 
materials on Gray Technical, LLC 's programs, software or Internet site, even if Gray Technical, LLC or a Gray 
Technical, LLC authorized representative has been notified orally or in writing of the possibility of such damage. 
Because some jurisdictions do not allow limitations on implied warranties, or limitations of liability for 
consequential or incidental damages, these limitations may not apply to you.  

5. Revisions and Errata  
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The materials appearing on Gray Technical, LLC 's software, programs or web site could include technical, 
typographical, or photographic errors. Gray Technical, LLC does not warrant that any of the materials on its 
software, programs or web site are accurate, complete, or current. Rig Steer may make changes to the materials 
contained on its program, software or web site at any time without notice. Rig Steer does not, however, make any 
commitment to update the materials.  

6. Links  

Rig Steer has not reviewed all of the sites linked to its Internet web site, program or software and is not responsible 
for the contents of any such linked site. The inclusion of any link does not imply endorsement by Rig Steer of the 
site, program or software. Use of any such linked web site is at the user's own risk.  

7. Site Terms of Use Modifications  

Rig Steer may revise these terms of use for its programs, software or web site at any time without notice. By using 
this software, program or web site you are agreeing to be bound by the then current version of these Terms and 
Conditions of Use.  

8. Governing Law  

Any claim relating to Gray Technical, LLC ‘s software, programs or web site shall be governed by the laws of the 
State of Kentucky without regard to its conflict of law provisions.  

General Terms and Conditions applicable to Use of a Web Site, Program or Software.  

Privacy Policy  

Your privacy is very important to us. Accordingly, we have developed this Policy in order for you to understand 
how we collect, use, communicate and disclose and make use of personal information. The following outlines our 
privacy policy.  

• Before or at the time of collecting personal information, we will identify the purposes for which 
information is being collected.  

• We will collect and use of personal information solely with the objective of fulfilling those purposes 
specified by us and for other compatible purposes, unless we obtain the consent of the individual concerned 
or as required by law.  

• We will only retain personal information as long as necessary for the fulfillment of those purposes.  
• We will collect personal information by lawful and fair means and, where appropriate, with the knowledge 

or consent of the individual concerned.  
• Personal data should be relevant to the purposes for which it is to be used, and, to the extent necessary for 

those purposes, should be accurate, complete, and up-to-date.  
• We will protect personal information by reasonable security safeguards against loss or theft, as well as 

unauthorized access, disclosure, copying, use or modification.  
• We will make readily available to customers information about our policies and practices relating to the 

management of personal information.  

We are committed to conducting our business in accordance with these principles in order to ensure that the 
confidentiality of personal information is protected and maintained.  

www.rigsteersoftware.com  
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Gray Technical, LLC 

Rig Steer 

Morehead 

United States 

1690 Sharkey Road 

Kentucky 

40351 

rigsteer@rigsteersoftware.com 

606-780-0554 

  

Last Edited on 2015-03-16 
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Why Rig Steer? 

 Rig Steer was created with a vision in focus; creating a new way of Geo Steering. We 
wanted to have a Geo Steering software that saved money, detoured from the use of ‘Blocks’, not 
require internet access, that felt and looked modern, to be user friendly and straight forward, but most 
of all to not use an Access based database.  

Rig Steer has many features that detour from the common expectations of a Geo Steering 
software. One of the main functions of this program is that Rig Steer does not require a Microsoft Access 
database; instead it runs solely on Excel.  The software interacts and stores data into excel, utilizing its 
advance calculation capabilities and displays them in easily understood graphs. With Excel as a 
backbone instead Access, Rig Steer opens the doors to many more users that do not have the upgraded 
professional version of Microsoft Office.  

Excel was created as a data analysis program that has its own built in mathematic logic. Access 
was made to be a database that’s main function is to store large amounts of data. When looking at the 
two options it would seem that the best choice for the Geo Steering Minimum Curvature calculations 
Excel would be the winner. However, Excel has one draw back that Access doesn’t have. Excel does not 
interact easily with other software like Access does. Because of this Excel is often pushed to the side as a 
choice of programming.  

Since other Geo Steering software utilizes Access, the calculations are not as advance as Excel. 
This is the reason why ‘Blocks’ are used instead of individual survey points. Each ‘Block’ is simply a 
different set of data in a new database that plots as a new graph over top of the existing one. Rig Steer 
uses one database that calculates one set of data, thus the end result is one solid target zone with none 
of the gaps that are created with each new ‘Block’. 

There is no internet activity needed to activate or run Rig Steer. With its advance calculus 
equations all product keys are computer specific and interchangeable between versions. For instance, if 
you purchase a license key, and then upgrade to the latest version of Rig Steer, there will be no need to 
purchase a new license, or pay an upgrade fee.  

Rig Steer has multiple options for individualization of charts and graphs. Every color is 
customizable to suit every user or client. With preset schemes it is easy to choose one that is already 
made or you can create your own.  

With no use of ‘Blocks’ the target zones plots as one solid line. Editing this line is as simple as 
picking a start point, end point, and moving he target zone up or down in order to match gamma. Or the 
user can line up two sections and auto-fill all the points between with the ‘Kill’ feature. This ‘Kill’ feature 
will auto draw all the points in the selected range to either fill  

If you prefer to use a ‘Block’ system though, there is an option available for this. Simply select 
your ranges, via points or depths, and select the corresponding sections with the 1, 2, 3, 4, or 5 key to 
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select and edit that section of gamma. This imitates the ‘Block’ feel without the headache involved in 
the maintenance of making your ending and beginning points line up.  

LAS files can be converted over to Excel files when needed. And with our Copy and Paste 
functionality it is easy to import new data into your project file.  

Rig Steer comes will a computer monitoring system as well. This built in program will monitor 
computer activity and usages to alert the user if the computer is about to crash or if the internet ever 
becomes disconnected.  

Rig Steer is also not limited in its email client. It has been designed to work with most email 
clients in order to improve productivity. With this boundary overstepped reports can be emailed directly 
to clients without any extra software.  

One of the most requested feature when designing this software was the layout of the buttons 
and functions. With the first time user in mind this software was designed to be easily navigated 
between options. Fewer tabs, more functions and less confusion was a necessary addition.  

We were also requested to reduce the number of multi-handed keyboard functions. By doing 
this the idea was to keep one hand on the mouse while leaving the other hand on one side of the 
keyboard at all times. This incorporated layout will allow the user to steer without ever moving their 
hands from the keyboard to the mouse, and back again, thus decreasing the amount of time require to 
accurately steer a well file. 

 Rig Steer, being in Beta, still has a way to go before it is considered a new advancement in Geo 
Steering. However, we have rethought the process from the ground up to make advancements in the 
Geo Steering field.  
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Basic Functions 

 

 This section breaks down the buttons and basic functions in the Rig Steer program. 

 

Main Chart 

 

Label Options  

This is the label option. This option, when on GREEN, will show the points 
in the graph. When this option is on BLUE it will show the points and the 
label depth on the graph. When this option is off (GRAY) it will not show 

any points or labels. 

 

 

 

 

Graph Options  

This is the Graph Options. This will open a new window in which the user 
can select which data set to display on the main chart.  

 

 

Color Options 

This will open a window which will allow the user to change the color 
options of the main chart. 
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Kill Button 

The Kill function will allow the user to LEFT CLICK on a starting point of 
the Target Zone and then RIGHT CLICK on an end point. This will hide all 
other points on the Gamma Chart except for the selected data. If the user 
HOLD SHIFT and then selects a start point and end point the program will 

kill the interpretation between both points, thus creating a straight line. 

 

 

 

Target Zone 

Activating this (GREEN) will show the target zone on the main chart. 
Activating this again (BLUE) will show target zone and selected tops in 
the ‘Customize’ option in the gamma section.  

 

 

Screen Capture 

Clicking this button will activate the screen capture program. Adjust the 
picture where you would like to capture and click ‘Take Picture’. You can 
then save the image as either a JPEG or PNG. 

 

 

3D Charting 

Currently unavailable in the Beta Version, this will allow the user to chart 
the current dataset in a 3D graph. 
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Area Plotter 

This will graph the selected tops on the main chart in an Area Plotter 
display. 

 

 

 

Project Export 

This option will allow the user to export the current project into an Excel 
File and Email it to the client. 
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Gamma Chart Buttons 

 

Open LAS 

This button will open an LAS file in an Excel format. 

 

 

 

 

Import Gamma Sheet 

This will start and import a new Gamma Sheet into the project. 

 

 

 

 

Export 

This will export all data into Excel, preparing the document for saving. 

 

 

 

 

Gamma Options 

This opens the Gamma Options for customization. 
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Multi Select  

With the Multi Select Deactivated (GRAY) the user can select one point 
on the Gamma Chart when HOLDING DOWN RIGHT CLICK and drag and 
drop it to manipulate the data. With the Multi Select Activated (GREEN) 

the user than select a starting point on the Gamma with a LEFT CLICK and 

an end point with a RIGHT CLICK and then manipulate all data between the two 
points with the MOUSE MOVE (scale) or by HOLDING SHIFT and MOUSE MOVE 
(move) to create a fault.   

 

 

 

Manual / Automatic 

When Manual is activated (GRAY) all points under selected when Multi 
Selecting do not move or scale with the selected points. When 
Automatic is activated (GREEN) all points under selected when Multi 

Selecting are moved or scaled with selected. 
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Additional Buttons 

 

Notes 

This will open an additional window allowing the user to write notes for 
themselves or someone else who will be steering the well. 

 

 

Refresher 

This will refresh all data. 

 

 

Save 

This saves the project 

 

 

Expand / Shrink 

This will expand or shrink the display of selected item 

 

 

Write 

This will write the information to Rig Steer, but not save the options on 
the project file 
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Additional Functions 

 

Keys And Mouse 

Mouse 

• LEFT CLICK to select a start point 
• RIGHT CLICK to select an end point 
• SHIFT 

• Used on Gamma Chart to create faults 
• Used on Main Chart to 

• Calculate Dip 
• Kill interpretation 

• Used on Data Import Grids to Select Range or Delete Range 
• MOUSE MOVE used in Gamma Selection to Scale selected data points 

 

Keys 

• ESCAPE is used to undo progress to last active save or refresh 
• S can be struck to SAVE progress (while editing gamma) 
• CONTROL and S can be struck to SAVE progress 
• SPACE or ENTER can be used to temporarily save data (NOT a real save) 
• D is used for nudging the selected graph or chart to the Right 
• A is used for nudging the selected graph or chart to the Left 
• W is used for nudging the selected graph or chart Up 
• S is used for nudging the selected graph or chart Down 
• Q is used for zooming with the mouse wheel on only the X axis 
• E is used for zooming with the mouse wheel on only the Y axis 
• DELETE key is used for deleting selected data 
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Zooming 

Click Drag-And-Drop Zoom 

• To ZOOM IN on a chart you need to LEFT CLICK on an area, HOLD DOWN the mouse click 
and DRAG-AND-DROP to the end of the ZOOM IN area. This will ZOOM IN into the selected 
area. 

• To ZOOM OUT click the Negative Button (-) beside the scroll bars after ZOOM IN is activated. 

 

Mouse Wheel 

 Rig Steer comes equip with a smart zoom feature that will zoom into a selected chart wherever 
the mouse is located. To activate this place your mouse on the area of the chart where you want to 
zoom, and roll the mouse wheel away from you to zoom in or toward you to zoom out.  

 Clicking on the mouse wheel will enable an auto pan feature to pan the charts up, down, left or right. 

 

Zoom Nudge 

 LEFT or RIGHT - When zooming with Rig Steer the user can nudge the chart or graph to the left 
or right with either the scroll bars or by pressing the ‘D’ Key for right and the ‘A’ key for left. 

UP or DOWN - When zooming with Rig Steer the user can nudge the chart or graph up or down 
with either the scroll bars or by pressing the ‘W’ Key for up and the ‘S’ key for down. 

 

Advance Zooming Options 

 When zooming, you can zoom in on either axis with the following functions: 

• Holding the ‘Q’ key while zooming will only zoom on the X axis. 
• Holding the ‘E’ key while zooming will only zoom on the Y axis.  

When zooming you can change the percentage of the zoom ration at the top right of the main 
Rig Steer window. By default it is set to 25%. In this section you can also toggle on or of the scroll bars if 
needed. 

If you ever need to reset the zoom function, the button at the bottom right of the main Rig Steer 
window, ‘Reset Zoom’ will reset the zoom on all charts and graphs back to the default zoom. 
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Installation and Registration 
 

Installation 
 
 In some cases it is required to install Rig Steer as ‘Administrator’ by right 
clicking on the installer and ‘Run as Administrator’. After installation you will be greeted 
with a window letting you know that you don’t have a license key.  
 After creating a license file Rig Steer will then greet you with a tutorial window. 
In this window you will find videos and text support documents, stepping you through 
how to do different functions in Rig Steer. These options are also available later from the 
Help > Tutorials menu option. 
 
  

Registration 
 
 Now that you have your software installed you can activate your program. If you 
have a license key already you can enter it in or import the license file itself. To type in 
the key first input the expiration date as follows MM (month), DD (date), YYYY(year), 
and then enter the license as shown in your confirmation email. To import you license file 
please select the “Import a License File” button and then locate the .xlsx license file send 
to you. 

 If you do not yet have a license you can Email a request for a Trial or for a 
Purchase Link to buy a license.    

 
 PLEASE NOTE – If there is a negative value in your license you will need to 
include the negative sign. 
 

The license keys are based on your computer specific number. Each computer is 
different, and the number is generated based on ALL of the hardware specs of the 
machine. It is highly suggested to purchase monthly subscriptions in case of key changes.  
 It is not required to have internet access in order to activate your program because 
of its advance calculus validation. If the key you receive is entered incorrectly your 
license will not activate.  
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Opening and Starting a New Project 

 

 In Rig Steer you can either Open a project or start a New project in 
the File Menu. In the Open section you will need to select a well file to load. If 
this well file was not created on your machine you will either need to open it 
first in Excel and ‘Enable Content’ for the macros, or go into Excels Advance 
Settings to enable all macros (for instructions please see Installation and 
Registration). 

 To start a New well file you will need to go to File > New. In the next 
window you will be asked to save the new well file. After you save the file you 
will be asked to input all required information to start a well.  

 

 Note – if any data here is unknown you can leave it blank and Rig Steer will fill it in for you 
automatically.
 

 

 In the green section you will be able to select how many surveys you plan on having on this well. 
This is the screen where you set your maximum size your project could be. The first Text Box at the top 
chooses your maximum Surveys. This will set the limit for all well files or interpretation on this well file. 
1,000 is the normal, however it can go up to 15,000. The next Text Box you can choose how many wells 
you plan on steering with this file. The maximum is 10, and is set to that be default. This will not affect 
the well file at all. The only reason why this is displayed is so the user can see an approximation on how 
large the final size of the well file will be.  
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 In the bottom right of the screen you can see an approximant project size, which will take your 
maximum survey count and your maximum steered wells to give you an estimate on how large the final 
project will be, and if it is able to be emailed. This is a handy little feature, however, if you are just 
setting it up for the first time you shouldn’t have to worry about the size of the document.  

 

 Note – If you set your maximum survey count too low then you will need to start a new well 
project in order to fix this.  

 

 In the last window you will need to select which way you would wish to steer. The three options 
you have is Minimum Curvature (default), Radius of Curvature or Average Angle. These can be changed 
later as needed, but for most cases Minimum Curvature is the option you will want to take.  

 

 

 The next step is to start a gamma sheet. This is done automatically when starting a new well file, 
however if there is an error and the data sheet was not created (notice the gray box 
on the left of the image above – this indicates that the gamma sheet was NOT 
created) will need to start a new gamma sheet manually. How you do this is go to 
the ‘Gamma Input’ tab on the left hand side of the screen and click on the ‘Import 
Gamma’ button.  
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 Once here, if you have the Type Log, you can go ahead and Copy and Paste the Type Log into the 
designated place in the Purple Section of the Gamma Data Grid (as shown in the window that displayed). 
After that click the ‘Export’ button to export the data into Excel.  

 

 If you need more information about Opening LAS please refer to the ‘Open LAS Files’ section of 
this manual. 

 

 

After this your project is set up. To save progress click the ‘Save’ icon.  

 

 Projects can automatically say by turning on the ‘Auto Save’ feature in the ‘Tools’ option on the 
main window. Doing so will automatically save your project after certain actions, like updating gamma, 
have be made. 
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Open LAS Files 

 

 LAS files can be opened in the Gamma Section page with the ‘Open LAS File’ button.  

 

 After clicking the ‘Open LAS Files’ button you will be greeted with this 
window to the right. In this window you can Manually Open, Setup Auto and 
Open Auto. 

 

Manually Open 

 When LAS Options are opened you can Manually Open LAS files by clicking the ‘Manual Open LAS’. From 
here you select the LAS file to open. The LAS file will then be converted into an excel document in which 
you can copy and paste data into your Rig Steer well file project.  

The Manually Open LAS option is primarily used to open Type Log Files. 

 

Auto Open LAS 

 Auto Open LAS files will allow the user to set a selection range on the LAS files and then 
automatically import the new LAS data into Rig Steer from the selected LAS file. First you will need to set 
up the LAS file ranges.  

 Click on the ‘Setup Auto LAS’. This will 
open an LAS file. From here take note of the LAS 
file rows and column numbers, inputting them 
into the correct box.  

 After the respected boxes are filled simply 
click the ‘Import’ button, close the LAS files and 
the Open LAS window. Reopen the window and click the ‘Auto Open LAS’. Select the LAS file you want to 
open and the program should automatically open and import the data into the correct place. 

NOTE – The ‘Reverse’ is for items that are in reverse order, and the ‘Gamma and Survey’ will add +1 to 
the row value every time to compensate for LAS files that have both gamma and surveys together.  
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Delimited LAS option 

 You may notice that in the tools menu you can find a ‘Delimited LAS’ option. This option when 
turned on (by default) will automatically open the LAS files and select what kind of delimited document 
the LAS file is. If this automatic feature does not produce the desired effect you can turn this option off 
and select the Delimited option yourself when opening LAS files. 

Delimited – Spaces 
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Input Surveys 

 Inputting survey data is as simple as Copy and Paste. Open the survey file, select the data you 
wish to import, COPY that data and PASTE it into Rig Steer. You can also select all the data in a range 
(even the ones already pasted in) if needed. Sometimes this will make it easier and faster than finding 
the last left off survey and only pasting in that value. After pasted in click “Update Start to End” to 
update all data and import it into excel, as well as populate the main chart.  

NOTE – if the AZM or INC has two or more lines of the same value it will throw an error producing a TVD 
value of -21000000. To fix this select the numbers that are the same and change them by a small 
amount (like 0 to 0.0001). This can be manually changed or automatically by the “Auto Survey Fill” in the 
Tools Menu (which is on by default). 
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Input Type Log / Survey for Gamma 

 

 Inputting surveys into the Gamma is just like inputting data into the regular surveys. Simply 
Copy and Paste into the correct places. The Type Log goes in the Purple Section while the Active Gamma 
Surveys go into the Green Section.  

 Note – The BLUE section and ORANGE section are not changeable. This does not mean that they 
are useless; on the contrary, they are very important. These sections are the areas that the calculations 
for offsets and tops are calculated.  
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 After the data is in the Data Grid you then need to Export it into Excel with the ‘Export’ button. 
This button will export all data into Excel and get the content ready for saving.  After export is complete 
you will see the Type Log and Gamma Files updated on the Bottom Gamma Chart and the Gamma Chart 
on the left.  
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Editing Gamma 

 

 When editing gamma there are multiple ways to edit and steer a well. This section will cover the 
basic most commonly used methods. Later we will cover the Advance options. 

 First you will need to know is the Button Functions (for more please refer to the Buttons and 
Functions shown previously in this book). There are many buttons related to the Gamma, however the 
only two that are mandatory are Multi Select and Manual / Automatic (shown below) 

 

Multi Select  

With the Multi Select Deactivated (GRAY) the user can select one point 
on the Gamma Chart when HOLDING DOWN RIGHT CLICK and drag and 
drop it to manipulate the data. With the Multi Select Activated (GREEN) 

the user than select a starting point on the Gamma with a LEFT CLICK and 

an end point with a RIGHT CLICK and then manipulate all data between the two 
points with the MOUSE MOVE (scale) or by HOLDING SHIFT and MOUSE MOVE 
(move) to create a fault.   

 

 

 

Manual / Automatic 

When Manual is activated (GRAY) all points under selected when Multi 
Selecting do not move or scale with the selected points. When 
Automatic is activated (GREEN) all points under selected when Multi 

Selecting are moved or scaled with selected. 
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 Scaling 

 

 To scale the gamma files you will first need to toggle ON the Multi Select. Use the LEFT CLICK to 
select a start point and RIGHT CLICK to select the end point. With the multi select on with a MOUSE 
MOVE you can scale the selected points.  

   

 

 If you hold SHIFT with the MOUSE MOVE you can move the selected points to a new location, in 
return you also create a FAULT.  
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 The next potion to look at is the Manual and Automatic. You have already seen the effect of the 
Manual (GRAY) function, if you have the AUTOMATIC on then all the points below the selected will be 
moved with the selected.    
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Gamma Display Options 

 

 Most times the default settings for the Gamma Display are not adequate for viewing all the 
input data. An example of this is shown below: 

 

To fix this you will need to go into the  ‘Customize’ tab on the left and changing the settings on 
the Min and Max settings for each Gamma and Gamma FT 
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The changed settings give this as a result. A fully viewable gamma section on both the left chart 
and the bottom chart.  

 

 

 

 

Showing Gamma Edits 

When editing gamma it is possible to show the gamma being edited on the main chart. This 
feature is turned on by default, and be toggled off in the “Tools” menu if desired. 

 

 

Please note 

When editing gamma, to view the target zone on the main graph you will need to activate the 
‘Target Zone’ button on the right hand side of the main window.  
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Straight VS Active Gamma 

You may notice that the chart at the bottom has a check box that reads “Show Log”. This, 
deactivated by default, will show the Type Log and the Gamma on the same plane when it is on. When 
off it will show only the Gamma, however it shows it in a Straight Plane. This is useful when the ‘Auto 
Locate’ tool is on and you can see your gamma as you are mousing over your target zone. 

 

Off Setting 

If you will need to offset the input gamma (ORANGE in the example) you simply change the 
‘Offset’ on the bottom right of the screen and hit ENTER or the INPORT button located beside it. 

Positive numbers will offset Gamma higher on the bottom chart, or closer to the right on the left 
chart, while negative numbers will offset Gamma lower on the bottom chart, or closer to the left on the 
left chart. 

-NOTE - For best result when offsetting gamma please select the ‘Show Log’ checkbox above the 
offset import button. 
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Main Survey Options 

Display Options 

You might notice that the default display option will only show one chart and also only the TVD 
verses Vertical Section (which shows an accurate display of the drill location under the earth). For 
steering purposes however you will need to change this orientation to TVD verses MD. This will allow 
the user to display the Target Zone and steer wells.  

 

Graph Options 

Clicking the ‘Graph Options’ button you will be greeted with a new window. This 
window now only has one option, which is the ‘Auto Populate’ checkbox. This box, which 
checked, will auto populate with the default settings. At this point you could choose to let 
the auto take control, and simply click on the “Target Zone” button to view the Target 

Zone and begin steering. However, the Auto will only allow one drill to be displayed at once. To display 
multiple drills at once you will need to deselect Auto Populate.  

          

When you deselect ‘auto’ you will see that more options become available. These options might 
be a little overwhelming at first, however there are only two that you really need to worry about, those 
being the ‘Clear Data’ and  ‘TVD and MD’. The first, ‘Clear Data Each Time’ will allow only one data set to 
be active, picking the first selected automatically. This can be helpful, but also annoying if you are trying 
to view more than one. In most cases leave this setting off.  

The next option is the ‘TVD and MD’. This will allow you to see the drill and Target Zone together 
in the same plain.  
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After you have these selected you can click the ‘Refresh’ button to view them on the main chart. 

 

 

The other options, as said before, are not as important now, however we will go ahead and 
explain them. At the top of the Graph Options window you will see ‘Data 1’, ‘Data 2’ and so on. These 
are each well or interpretation for each project file. This will give the user the ability to view up to ten 
different wells or interpretations at one time.  

The options ‘X inverted’ and ‘Y inverted’ IN RED will effect the main chart, if the X axis or Y axis is 
inverted. The GREEN affects the second chart, which displays the North South East West direction of the 
drill.  
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Targets and Tops 

 

With the ‘TVD and MD’ selected in the ‘Chart Options’ window you can now view the target 
zone and tops. To view the target zone all you will need to do is click the ‘Target Zone’ button. 

 

Target Zone 

Activating this (GREEN) will show the target zone on the main chart. 
Activating this again (BLUE) will show target zone and selected tops in 
the ‘Customize’ option in the gamma section.  

 

Toggle it onto green to view the Target on the main chart.  
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To view the Target Tops you will need to go to the ‘Customize’ tab on the left and then Toggle 
on selected Target Zones in that tab and click the ‘Write’ button (the feather). With the selected on you 
want click the ‘Target Zone’ button again until it is blue. Then you will see the tops plotted with the 
Target Zone on the main chart, as well as the Gamma Graphs. 

If you need to edit, add or remove tops names or depths simply write the changes in this 
window and then click the ‘Import’ button to import the data into excel and change the data. 
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Area Plots 

 

With the tops selected in the ‘Customize’ tab you can display the tops as an Area Plot by clicking 
the ‘Area Plotter’ button.  

 

Area Plotter 

This will graph the selected tops on the main chart in an Area Plotter 
display. 
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Screen Capture 

 

The built in screen capture button is a very nice feature that will allow the user to take a screen 
shot of a selected area and save the image as either a JPEG or a PNG. What is very convenient about this 
screen capture is that the average file size of a saved image is under 200kb, which means in the average 
email you could attach 500 screen shots and still send the message.  

 

Screen Capture 

Clicking this button will activate the screen capture program. Adjust the 
picture where you would like to capture and click ‘Take Picture’. You can 
then save the image as either a JPEG or PNG. 

 

 

 To activate this click the button and then scale the window to the size you want. Once 
scaled click ‘Take Picture’ and save picture in desired location.  
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Export Well File 

 

Project Export 

This option will allow the user to export the current project into an Excel 
File and Email it to the client. 

 

 

 By clicking this button you will open a new window in which you can chose chart information from your 
LAS Gamma Files. Pressing ‘Preview’ will allow you to view your selected data sets. You can change the Y values of 
the charts to better match the desired final export. When you are ready click the ‘Submit’ button and all of your 
data will be exported into an Excel document that you can email or send. 

 Note – This will take a screen shot of all of your data, graphs, and charts in the respected color schemes.  
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Main Survey Advance Options 

 

Dip Calculator 

The Dip Calculator can be activated as long as you have the Target Zone activated. How you 
activate the Dip Calculator is by HOLDING SHIFT on the main chart and LEFT CLICKING a start point, and 
then RIGHT CLICK an end point (while still HOLDING SHIFT). When holding SHIFT your DRILL DOWN TOOL 
(if activated) will change to GREEN in indicate the dip calculator being activated.  

 

What you will notice when you do this is that the selected area changes colors and that the 
GREEN numbers above change while the ORANGE numbers below change as well. These numbers are 
your Dip.  

The GREEN numbers above represent the Average Dip. This takes the averages of all the points 
between the two selected. ‘Point 1’ gives you the X and Y values of first point selected (start point), 
‘Point 2’ represents the second points values (end point), ‘Y’ represents the Y average, the ‘X’ represents 
the average of X values, ‘C’ is the average of the distance between the two points and ‘Dip’ is the 
calculations of the Dip – First section being the average percent, while the second set of numbers is the 
average angle set at 90 degrees.   

The ORANGE numbers below represent the Point to Point Dip. This only looks at the Start Point 
and the End Point and gives you the Dip between the two. ‘Point 1’ gives you the X and Y values of first 
point selected (start point), ‘Point 2’ represents the second points values (end point), ‘Y’ represents the 
value of the Y, the ‘X’ represents the value of X, ‘C’ the distance between the two points and ‘Dip’ is the 
calculations of the Dip – First section being the percent, while the second set of numbers is the average 
angle set at 90 degrees.   
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Color Options 

 

 To access the Color Options for the main chart you will need to click on the ‘Color 
Option’ button located on the right hand side of the screen. 

 

Color Options 

This will open a window which will allow the user to change the color 
options of the main chart. 

 

 

In this window you can change the color options 
for the main chart. The top sections gives you the options 
for each Data Set (DS) and each type of display (TVD and 
Vertical Section OR TVD and MD). When you change these 
colors the colors will also change on the ‘Color’ beside it.  

The lower options in GREEN will change the 
directional colors for each data set. 

Below the color blocks you will see the 
‘Background Color’ option and ‘Grid Color’ option. These 
options will change the Background Color of the charts 
and the Grid Colors of the charts.  

The ‘Line Width’ will also change the line widths of 
the chart.  

To write these changes to the chart you will need 
to click the ‘Write’ button. To save the workbook you can 
click ‘Save’. 

NOTE – if you would like to not see the grid lines 
you can simply change the color of the grid lines to the 
same color as the background.  
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Label Options 

 

Label Options  

This is the label option. This option, when on GREEN, will show the points in the 
graph. When this option is on BLUE it will show the points and the label depth on 
the graph. When this option is off (GRAY) it will not show any points or labels. 

 

 

 

 

 

NOTE – With the labels being displayed, your computer my slow do to the amount of processing 
power it takes to display the 10,000+ labels that can be displayed on some well files.   

 

Changeable Name 

Though a not necessary to do, you can change the name of the data set at the top of the 
screen to anything you want by simply typing in a name and clicking the ‘Pencil’ button to save 
the name.  
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Gamma Advance Options 

 

Color Options 

To get to the color gamma options you will need to open the ‘Gamma Options’ button. 

 

Gamma Options 

This opens the Gamma Options for customization. 

In the first screen you will see a bunch of options that are not available in the Beta 
Version. In the future this is where you are going to be able to select what to plot on the 
Gamma chart and what to steer with (Gamma [the only option available in Rig Steer Beta], 
Temp, ect.). For now the only think you can do is extend the display with the expand arrow.  

 

Expand / Shrink 

This will expand or shrink the display of selected item 

 

 In the extended window you will now see several color options which I will explain. 
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 The top section will change the color and display options of both Gamma Charts, and 
are pretty self-explanatory.  

 

Background – changes the background color 

Type long – changes the type log color 

Gamma marker – changes the gamma marker color (if marker is turned on) 

Gamma color – changes the gamma color 

Line Width – changes the width of the line 

Last Selected – changes the color of the last selected 

Selected color – changes the color of the currently selected 
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Sectionals 

Sectional Point Display 

 

 With the default display option ‘Sectionals Points’ is automatically selected. With this 
option you can set sections by points. By default the amount of sections is set to 60. This, on 
average, would be 2 survey points per section.  

With the toggles on the right you can select which section you would like to display with 
what color. The sections are layered 1 to 5 (1 being the oldest, 5 being the newest).  

NOTE – if you would like to show ONLY the sectionals then select ‘Show Sections’ at the 
top instead of ‘Show All Gamma’.  
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Depth by Columns 

 

 

 By selecting the ‘Depth by Columns’ button you will see that there is a new section at 
the bottom of this window. What this will do is allow the user to set a column (now only the 
MD is useable with the Beta Version), and with that column you can change the color of 
selected depths.  

The depths are not preset, so you will need to type those in yourself. When you toggle 
on a section, from that depth to the one under it (the start of the new section) will be changed 
to that color. You will need to have a number under that so the chart coloring knows where to 
end.  

NOTE – if you would like to show ONLY the sectionals then select ‘Show Sections’ at the 
top instead of ‘Show All Gamma’.  
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Block Editing 

 

         

 When either the Sectional Points or Depth by Columns is activated, pressing the 1, 2, 3, 
4 or 5 key will tell Rig Steer to select that section of gamma. With this method the user can 
mimic the use of blocks without having the headache of trying to match up every end and 
beginning data point. 

 

  

Rig Steer Beta Version 0.1.1.9 Manual Page 52 
 



Kill Button 

Kill Button 

The Kill function will allow the user to LEFT CLICK on a starting point of 
the Target Zone and then RIGHT CLICK on an end point. This will hide all 
other points on the Gamma Chart except for the selected data. If the user 
HOLD SHIFT and then selects a start point and end point the program will 

kill the interpretation between both points, thus creating a straight line. 
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Kill Display 

 

As mentioned above, there are two functions to the Kill button. The first is a Kill Display 
option. With this option you can hide all the gamma on the left and bottom graphs EXCEPT for 
the area you selected from the main chart.  

How you accomplish this is by toggling on the Kill Button. Doing so will change the color 
of the button to red, and the color of the Drill Mouse Tool to blue. From there you LEFT CLICK 
on a start point and RIGHT CLICK on an end point on the main graph Target Zone.  
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Kill Interpretation 

 The second function that this button has is the ability to Kill and interpretation. What 
this means is that if an interpretation becomes ‘out of whack’, so to speak, you can select a 
start point and end point and then create a straight line between the two. Doing this will, as the 
name says, Kill the interpretation. 

 To Kill the Interpretation you will need to have the Kill Button ON (RED) and then HOLD 
SHIFT. HOLDING SHIFT will change the text color in the Drill Mouse Tool to RED. With the SHIFT 
HELD you need to LEFT CLICK to select a start point and RIGHT CLICK to select an end point. 
After that you will see that the interpretation between the two points has been ‘killed’.  

 At this point you can either click the ‘Import’ button to save, click the ‘S’ button to save, 
press ENTER or SPACE to temporary  save, or the ESCAPE button to back up or undo. 
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Advance Rig Steer Options 

 

 These options are for the Rig Steer program itself, not so much for an individual chart or 
one function.  

 

Active Dip Tool 

 This tool, when turned on, will display an live active dip of the target zone and tops on 
the main graph when editing gamma. 

 

Auto Locate 

 This tool, when turned on, will activate the location of either the Target Zone or Main 
Drill on both Data Grids as well as Gamma Graphs. 

 

Auto Save  

 The Auto Save function when activated will periodically save your progress on your 
projects incase of system failure. When saving you will see an animated loading icon in the 
bottom right hand corner of your screen. When this icon is shown your project is saving. You 
can toggle this function on or off in the Tools > Auto Save. Gray means that the tool is ON while 
no color indicates that it is off.  

 

Auto Survey Fill 

 Auto Survey Fill will automatically correct any errors found in the survey files when 
imported into Rig Steer. 
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Crosshairs 

 This tool will activate a crosshair curser option for your program.  

 The color options for the Crosshairs are RED – WHITE – BLACK – GREEN – YELLOW . The 
user can only activate one crosshair option at a time, and only one color at a time.  

 

Delimit LAS 

 Delimit LAS is an auto LAS file delimiter. This will determine which way an LAS file should 
be delimited. 

  

Error System 

 This tool, found in Tools > Error System, when on will show all errors the program may 
encounter. If the tool is turned off only the major system errors will be shown.  

 

Mouse Drill Tool 

 This tool is the Label that follows the mouse on the main chart. It shows the X and Y 
values for that position on the chart. You can toggle this on or off by going to Tools > Mouse 
Drill Tool.  The WHITE lettering is activated with the normal Drill Tool, GREEN is when you are 
calculating the dip (by holding SHIFT), BLUE is when you have the KILL BUTTON activated and 
wanting to only show a selected portion of gamma, and RED when the KILL BUTTON is activated 
and you would like to kill the interpretation between two active points.  
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System Monitor 

 The System Monitor can be accessed by going to ‘Windows’ > ‘System Monitor’. In this 
new window you will see these options. 

 

 The first bar will display your current RAM usage. The next bar is the CPU usage. Under 
the CPU is a internet connection.  Under the internet connection there is a warning system that 
will alert you if you RAM or CPU usage gets too high, or if your internet becomes disconnected.  

 To the right of the screen is a Windows Task Manager. With this program you can find 
programs that are running and you can terminate said program. 

 With the numbers below the warning system you can change the refresh rate, the RAM 
usage warnings, CPU usage warnings, RAM and CPU color display change.  

 It is recommended that you turn on the ‘Warning System’ to warn you if your computer 
becomes disconnected or if your computer is close to crashing. This can save you from having 
loss of data from crashes or system shut downs.  
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Color Schemes 

 

 There are many options for colors with Rig Steer however there are several preset 
schemes available in ‘Windows’ > ‘Color Options’ > ‘Color Schemes’. These color schemes can 
be activated by simply clicking on them. 

 

Default (the one that is auto loaded every time) 
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Aperture 

 

Light 

 

Midnight 
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Neo 

 

Retro 

 

Rig Steer 
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95 

 

 

 

Custom Color Schemes 

 Custom color schemes can be activated by setting all your colors to your preference and 
then selected ‘Windows’ > ‘Color Options’ > ‘Color Schemes’ > ‘Custom1’ > ‘Write’. This will 
write your current settings to Custom1.  

 If you would like to use a custom color scheme select the ‘Use’ button. The ‘Delete’ 
button will turn the custom color scheme back to default.  
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Notes 

 

Notes 

This will open an additional window allowing the user to write notes for 
themselves or someone else who will be steering the well. 

 

 

 These notes can be saved on the well file and opened up. These notes are used as 
reminders and also as notes that can be passed between people that are sharing a well file 
between shifts.  
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Tutorials 

 When first installing you will be greeted with the tutorial window. If you ever need to 
revisit this page all you need to do is go to ‘Help’ > ‘Tutorials’ and select which tutorial you want 
to view.  
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Microsoft, Office, Encarta, MSN, and Windows are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries. Gray Technical does not take any 
ownership or responsibilities for Microsoft related or trademarked products.  

 

•  Microsoft .NET is software for connecting people, information, systems, and devices.  
•  Microsoft Access is a registered trademark of Microsoft Corporation in the U.S. and other countries.  
•  Microsoft and Excel are either registered trademarks or trademarks of Microsoft Corporation in the United States 
and/or other countries. 

•  Microsoft and Internet Explorer are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries. 

•  Microsoft and Visual Studio are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries. 

•  Microsoft and Visual Studio are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries.  
•  Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United 
States and/or other countries.  
•  Microsoft and Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the United 
States and/or other countries. 

•  Microsoft is either a registered trademark or a trademark of Microsoft Corporation in the United States and/or 
other countries.  
•  Microsoft is either a registered trademark or a trademark of Microsoft Corporation in the United States and/or 
other countries. Microsoft Exchange server is a product name of Microsoft Corporation in the U.S. and other 
countries.  
•  Microsoft is either a registered trademark or a trademark of Microsoft Corporation in the United States and/or 
other countries. Microsoft Mail is a product name of Microsoft Corporation  
•  Microsoft is either a registered trademark or a trademark of Microsoft Corporation in the United States and/or 
other countries. Microsoft Word is a product name of Microsoft Corporation.  
•  Microsoft is either a registered trademark or a trademark of Microsoft Corporation in the United States and/or 
other countries. Windows is a registered trademark of Microsoft Corporation in the U.S. and other countries.  
•  Microsoft Office and Excel are either registered trademarks or trademarks of Microsoft Corporation in the United 
States and/or other countries. 

•  Microsoft Office is either a registered trademark or a trademark of Microsoft Corporation in the United States 
and/or other countries.  
•  Microsoft, Windows Server are either registered trademarks or trademarks of Microsoft Corporation in the United 
States and/or other countries. 
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